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1 Overview 

 
TWR-ADCDAC-LTC Lab Guide describes the procedure for setting up a Freescale Tower peripheral 
TWR-ADCDAC-LTC analog module and demonstrates its usage. A readymade web enabled application 
using Freescale MQX™ RTOS is used for the demo purpose. Other than TWR-ADCDAC-LTC Tower 
Module, a Tower MCU module TWR-K60D100M (using IAR IDE) and a Tower peripheral module TWR-
SER are also used. The first few sections of this manual describe the setting up of Freescale Tower 
hardware and remaining sections describe the usage of development tools. 
 
This lab guide also describes the procedure for setup and execution of TWR-ADCDAC-LTC Demo Suite. 
This suite of software uses an embedded webserver to control the actions of both the MCU module 
and the TWR-ADCDAC-LTC analog module. An embedded USB host is utilized to store web pages and 
can also be used for data logging. Figure 1 shows the block diagram of the Demo Suite software and 
hardware system. Follow the steps in the relevant sections below to set up and go through the demo 
software. 

 

Figure 1. TWR-ADCDAC-LTC Demo Suite System Overview 

 

1.1 TWR-ADCDAC-LTC Hardware Overview 
The TWR-ADCDAC-LTC is a Freescale Tower-compatible high-precision analog peripheral module with 
the following features: 

 Controllable by any Freescale Tower controller module with an SPI interface 
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 Two Linear Technology digital-to-analog converters (DACs) 
o LTC2704-16: Quad 16-bit voltage output SoftSpan™ DAC with readback 
o LTC2600: Octal 16-bit rail-to-rail DACs 

 Two Linear Technology analog-to-digital converters (ADCs) 
o LTC1859: 8-channel, 16-bit, 100 ksps SoftSpan ADC with shutdown 
o  LTC2498: 24-bit 8-/16-channel delta sigma ADC with Easy Drive™ input current 

cancellation 

 Linear Technology voltage regulator 
o LTC3471: Dual 1.3A, 1.2 MHz boost/inverter 

 Linear Technology voltage reference 
o LTC6655-5: 0.25 ppm noise, low drift precision buffered 5V reference 

 Four 14-pin headers for connecting to any Linear Technology QuikEval™ demonstration board 
 

 

Figure 2. TWR-ADCDAC-LTC Feature Call-outs 

 

2 References 

 
For more information on the Freescale Tower System refer http://www.freescale.com/tower. 
The documents listed below should be referenced for more information on the Freescale TWR-
ADCDAC-LTC. 

 TWRADCDACLTCQSG: TWR-ADCDAC-LTC Quick Start Guide  

 TWRADCDACLTCUM: TWR-ADCDAC-LTC User’s Manual 

 TWRADCDACLTCSCH: TWR-ADCDAC-LTC Schematics 
 

http://www.freescale.com/tower
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These documents can be found in “Featured Documentation” section of TWR-ADCDAC-LTC Product 
Summary Page. 
 http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=TWR-ADCDAC-LTC# 
 
 

3 Hardware Configuration of TWR-ADCDAC-LTC 

The hardware components required to run a demo using the TWR-ADCDAC-LTC Demo Suite are: 

 Tower MCU Module: TWR-K60D100M(instructions for setup are provided in this document) 

 Tower Analog module TWR-ADCDAC-LTC 

 Tower Serial module TWR-SER 

 Pair of Tower Elevators TWR-ELEV 

 USB mini-B to A adapter (provided in TWR-ADCDAC-LTC box) 

 USB Memory Stick (not provided) 

 Various cables and wires (provided) 

 Development Computer 
 
The default jumper shunt positions for the TWR-ADCDAC-LTC are marked as RED in Figure 3, and 
shown in bold enclosed within asterisk (for SPI0) in Table 1. 
The Tower MCU module and TWR-SER should be configured to settings as described in the relevant 
sections later in this document. 

 

Figure 3. TWR-ADCDAC-LTC Default Jumper Settings 

http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=TWR-ADCDAC-LTC
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Table 1. TWR-ADCDAC-LTC Default Jumper and Switch Settings 

Jumper Option Setting Description 

J1 - J8 QuickEval I2C/SPI Selection 
1-2 Connect I2C signals to QuickEval header 

*2-3* Connect SPI signals to QuickEval header 

J9 SPI Port Selection -- SPI_CLK 
*1-2* Use SPI_CLK signal from SPI0 

2-3 Use SPI_CLK signal from SPI1 

J10 SPI Port Selection -- SPI0_CSx 
*1-2* Select SPI0_CS0 

2-3 Select SPI0_CS1 

J11 SPI Port Selection -- SPI1_CSx 
1-2 Select SPI1_CS0 

2-3 
*OFF* 

Select SPI1_CS1 
SPI1 not used 

J12 SPI Port Selection -- SPI_MOSI 
*1-2* Use SPI_MOSI signal from SPI0 

2-3 Use SPI_MOSI signal from SPI1 

J13 SPI Port Selection -- SPI_MISO 
*1-2* Use SPI_MISO signal from SPI0 

2-3 Use SPI_MISO signal from SPI1 

J25 SPI Port Selection -- SPI_CS 
*1-2* Use SPI0_CSx (see J10) 

2-3 Use SPI1_CSx (see J11) 

J14 SPI Chip-Select Encoding  Bit 0 Setting 

1-2 Connected to 3.3V 

2-3 Connected to GND 

*OFF* Driven by GPIO9 

J15 SPI Chip-Select Encoding  Bit 1 Setting 

1-2 Connected to 3.3V 

2-3 Connected to GND 

*OFF* Driven by GPIO8 

J16 SPI Chip-Select Encoding  Bit 2 Setting 

1-2 Connected to 3.3V 

2-3 Connected to GND 

*OFF* Driven by GPIO7 

J28, J29, 
J31, J32 

LTC2704 VOSx GND Connection 
*ON* Connect VOSA, VOSB, VOSC, VOSD to GND 

OFF Disconnect VOSx from GND 

J30 Tower Power Connection 
ON Connect on-board 5V rail to Tower System 

*OFF* Isolate on-board 5V rail from Tower System 

J34 LT3471 Shutdown 
*1-2* LT3471 voltage regulator enabled 

2-3 LT3471 voltage regulator disabled 

J37 LTC1859 Reference Voltage Selection 
ON Use output of LTC6655-5 as reference 

*OFF* Use GND as reference 

 

 

4 TWR-K60D100M Setup using IAR 

This section describes how to setup the TWR-K60D100M as the Tower MCU module used to run the 
Demo Suite and interface to the TWR-ADCDAC-LTC.   
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4.1 Hardware Setup 
Using the TWR-K60D100M board with the TWR-SER board requires the following jumper modifications 
to be made: 
 
1. On the TWR-K60D100M board: 

 
a. Change jumper J10 to pins 2-3 to use the 50 MHz clock from the TWR-SER board. 
b. Change jumper J12 to pins 2-3 to connect VBAT to the higher voltage between on-board 

3.3 V supply or coin-cell supply. 
 

 

Figure 4.  TWR-K60D100M module J10 & J12 jumper settings 

The remaining jumpers should be placed in their default locations as described in its 
User’s Manual. Below is a summary of the required TWR-K60D100M jumper settings for 
use with this project. Review the following table and ensure that the jumpers are 
populated appropriately. 
 

Table 2. TWR-K60D100M Jumper Settings 

Jumper  Option  Setting  Description  
J4 USB VREGIN Power 

Connection  
ON Connect USB0_VBUS from Primary Elevator (A57) 

to VREGIN  

J2 Infrared Transmitter 
Connection  

OFF 
(no jumper) 

Disconnect PTD7/CMT_IRO/UART0_TX from IR 
Transmitter (D3) 

J10 Clock Input Source 
Selection  

2-3 Use 50 MHz external oscillator on TWR-SER board 

J12[2:3] 

J10 [2:3] 
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J14 MCU Power Connection  ON Connect on-board 3.3V supply to MCU  

J12 VBAT Power Selection  2-3 Connect VBAT to the higher voltage to the coin-
cell supply  
 

J19 
 

OSJTAG Mode Selection  
 

OFF 
(no jumper) 

Debugger Mode 
 

J15 JTAG Power Connection  
 

OFF 
(no jumper) 

Disconnect on-board 5V supply from JTAG port  
 

 
2. On the TWR-SER board: 

 
a. Change jumper J2 to pins 3-4 to provide a 50 MHz clock to the Ethernet PHY module 
b. Add jumper to J3 pins 2-3 to bring up the 50 MHz clock from the TWR-SER board 
c. Add jumper to J12 pins 9-10 to configure the Ethernet PHY module for RMII mode 
 

 
 

 

Figure 5. TWR-SER Jumper settings for J2, J3, J12 

 
The remaining jumpers should be placed in their default locations as described in its 
User’s Manual. Below is a summary of the required TWR-SER jumper settings for use 
with this project. Review the following table and ensure that the jumpers are populated 
appropriately. 

J2[3:4] 
J3[2:3] 

J12[9:10] 
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Table 3. TWR-SER Jumper Settings for use with TWR-K60D100M 

Jumper  Option  Setting  Description  
J2 Ethernet PHY Clock Select 3-4 50 MHz 

J3  CLOCKIN0 Driver Select 2-3 Route 50 MHz clock to CLOCKIN0 

J5 CAN Selection Options 1-2 Put CAN transceiver into sleep mode 

3-4 Connect Sleep pin to CAN pin (B43) 

5-6 Connect RXD pin to CANRX pin (B41) 

7-8 Connect TXD pin to CANTX pin (B42) 

9-10 Apply 120-ohm termination resistor 

J6 Ethernet PHY Interrupt 
Select 

Open 
(no jumpers) 

 

No PHY interrupts selected 

J7 CAN Transceiver Input Open 
(no jumpers) 

 

J10 USB VBUS Select 1-2 Supply 5 V on USB Connector (Host Mode) 

J11 USB OTG Interrupt Select Open 
(no jumpers) 

No USB OTG interrupts selected 

J12 Ethernet PHY 
Configuration 

9-10 
All other 
pins open 
(no jumpers) 

Pull-up CONFIG0; RMII Select 

J13 Misc RS232/485 Config Open (no 
jumpers) 

 

J15 RS232 / RS485 Select 1-2 RS232 

J16 USB Mode Select 1-2 Host Mode – supply 5 V to VBUS 

J17 RS232 / RS485 RX Select 1-2 RS232 

J18 RS232 / RS285 RTS Select Open (no 
jumpers) 

 

J19 RS232 / RS285 TX Select 1-2 RS232 

 
Assemble the Tower system consisting of the TWR-K60D100M, TWR-SER and TWR-ADCDAC-LTC.  Be 
careful to match the Primary edge of each module to the Primary (or Functional on older systems) 
TWR-ELEV module.  
 
Make the following connections from the Tower System to the development computer: 
1) USB cable between the computer and the TWR-K60D100M module power/debug USB 

connector. 
2) USB cable between the computer (or, optionally, a wall-adapter power supply) and the USB 

connector on the TWR-ADCDAC-LTC. 
3) Serial cable from the computer to the DB9 on the TWR-SER (optional, serial cable not 

included). 
4) Ethernet cable between the TWR-SER and Ethernet port on computer. 
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Figure 6. TWR-ADCDAC-LTC + Tower MCU Assembly (TWR-SER not pictured) 

 

4.2 IAR Embedded Workbench IDE for ARM v6.60 
This section provides a walkthrough for setting up the TWR-ADCDAC-LTC Demo Suite using IAR 
Embedded Workbench IDE for ARM v6.60 
 
5 Install IAR Embedded Workbench IDE (latest version is 6.60 at the time of this writing): 

 
a. Install IAR Embedded Workbench IDE for ARM (need v.6.10.2.x or higher)  –  

http://www.iar.com/ (see figure below) 
 

     
 
 
 

 

http://www.iar.com/
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b. Install drivers for PEmicro (see figure below) 
 

    
 
 

2. Install MQX RTOS version4.0.2 – 
http://www.freescale.com/webapp/sps/site/homepage.jsp?code=MQX_HOME 
NOTE: If you are running Windows Vista or Windows 7, it is recommended that you install 
MQX outside of the default C:\Program Files\ directory. Windows UAC prevents writes to 
that directory if you are not running as administrator.  Regardless of where MQX is installed, 
ensure that you have read and write access to the parent MQX folder and all of its 
subdirectories. 
Restart the system after installation. 

 
3. Unzip the attached TWR-ADCDAC-LTC Demo Suite.zip and copy 

twradcdacltc_demosuite_v2.0 folder into the <MQX Installation Directory>\demo folder 
(<MQX installation directory> is C:\Program Files\Freescale\Freescale MQX x.x 
by default). 

 
4. Open IAR Embedded Workbench IDE for ARM. 
 
5. Open TWR-ADCDAC-LTC.eww:  Select the menu File-> Open Workspace… and navigate to 

the twradcdacltc_demosuite_v2.0 folder which was copied earlier in step 3. Now select iar. 
Select TWR-ADCDAC-LTC.eww. 

 
a. In the Workspace navigation pane at the left, ensure Int Flash Release is selected in the 

Workspace drop-down menu (see figure below). 
 

http://www.freescale.com/webapp/sps/site/homepage.jsp?code=MQX_HOME
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b. To ensure proper project settings: 
 

o Right click on workspace TWR-ADCDAC-LTC in the left project navigation area and 
then click on Options (see figure below): 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

o To select the proper device, click on General Options category in the left column--> click on 
Target tab --> select Device(radio button) --> browse to select the device "Freescale 
MK60DN512xxx10" (see figure below) 
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o Again, in the left column, Category, click on Linker; under the Config tab, make sure the 
Override default option is checked and ensure that the value for Override default  file is 

$PROJ_DIR$\..\..\..\lib\twrk60d100m.iar\release\bsp\intflash.icf  (see figure below) 
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o Click on Debugger category and under the Setup tab, make sure Driver is PE_micro:                      
(see figure below) 

 

 
Still in the Debugger category, select the Download tab, and make sure the Use 
Flash Loader(s) and Override default .board file options are checked. Ensure that 
the value for Override default .board file is 

$TOOLKIT_DIR$\config\flashloader\Freescale\FlashK60Dxxx128K.board (see figure below) 
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o Click OK to exit the Project Options dialog box. 

c. Save workspace from “File Menu -> Save Workspace”. 

 

6. The source code is provided with pre-built binary. However, if you are flashing the TWR-
K60D100M board for the first time after MQX installation, a modification needs to be made 
to the prebuilt TWR-K60D100M MQX BSP—a timer used by the TWR-ADCDAC-LTC Demo 
Suite which is OFF by default. Also, the SPI2 module needs to be enabled. We need to make 
changes in the configuration file and rebuild the MQX libraries: 
a. Select File->Open Workspace 
b. Navigate to the <MQX Installation Directory>\config\ twrk60d100m \iar directory. 
c. Open build_libs.eww. This step will close the TWR-ADCDAC-LTC.eww workspace. 
d. At the bottom of the Workspace navigation pane, see below, click the button 

bsp_twrk60d100m: 
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e. In the Workspace navigation pane at the left, select Release from the Workspace drop-
down menu: 

 
 

f. In the Workspace navigation pane at the left, find the folder labeled twrk60d100m User 
Config then double-click the file user_config.h to open it. 

g. In user_config.h, ensure that MQX_USE_TIMER is defined as follows (change the 
define from a “0” to a “1” or add this line if needed): 

 
#define MQX_USE_TIMER            1 

h. Ensure that the SPI2 modules are enabled by modifying the following defines in the 
user_config.h file so that they are set to 1. If these defines are not present in 
user_config.h, then add them: 

 
#define BSPCFG_ENABLE_SPI2       1 
#define BSPCFG_ENABLE_ISPI2      1 

i. Batch build mqx libraries: 
o Under Project menu click Batch build. 
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o In Batch Build dialog box, select Release and click Make button. 
 

 
 

This step will take several minutes to build bsp_twr60d100m, psp_twr60d100m, 
rtcs_twr60d100m, usbd_twr60d100m, usbh_twr100m libraries successively one 
after another. No errors should appear after the Make operation. You may ignore 
any warnings. 
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o Close the build_libs.eww workspace.  
 

j. Re-open the TWR-ADCDAC-LTC.eww workspace. Make sure Int Flash Release is 

selected from the Workspace drop-down menu and click the Make icon , as shown 
below: 

 

 
 

No errors should appear after the Make operation. You may ignore any warnings. 
 

7. Connect a USB cable between your development computer and the TWR-K60D100M 
PWR/OSBDM USB connector. 

       Wait till windows finish installing drivers for Open source BDM- Debug Port and PE Micro 
USB Serial Port. Now you should be able to see drivers name listed in windows device 
manager as shown below. 
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8. Program the flash by clicking the Download and Debug button . Alternatively, you may 
select Project->Download and Debug from the menu. The internal flash of the K60DN512 
MCU on the TWR-K60D100M is now programmed with the Demo Suite software.  IAR 
Embedded Workbench IDE can now be closed unless you wish to step through the software.  

 
 

5 Running the Demos 

The TWR-ADCDAC-LTC uses an embedded web server to provide a graphical user interface with 
controls for the ADCs and DACs.  This section describes how to connect to the embedded web server 
and demonstrate the analog interfaces. 

5.1 Connecting to the Web Server 
Follow these steps to run the embedded web server and connect to it using a web browser: 
 
1. Assemble and connect the computer to the Tower System as explained below: 

 
a. Connect a USB cable between the computer and the TWR-K60D100M power/debug USB 

connector. 
b. Connect a USB cable between the computer (or optionally, a wall-adapter power supply) and 

the USB connector on the TWR-ADCDAC-LTC. 
c. Ethernet cable between the TWR-SER and Ethernet port on the computer. 
d. Ensure that the power indicator LEDs are lit on all the modules including the GREEN LED on the           

TWR-ADCDAC-LTC. 
 
5 The default IP address of the Tower System is 192.168.0.3 (set in config.h in the 

twradcdacltc_demosuite_v2.0). Typically, when you connect your computer directly to the 
Tower, the computer will default to an auto IP address on the same subnet as the Tower 
(192.168.x.x), therefore requiring no setup to the internet connection settings on the 
computer. Note, the computer may take a few minutes to default to the auto IP address 
and may report “Limited or No Connectivity”.  Alternatively, you may configure the IP 
address of the computer manually to be 192.168.0.4 with a subnet mask of 255.255.255.0. 
See the Troubleshooting section below if there is an issue connecting to the embedded web 
server. 

 
3.   Program the Tower MCU module as described in the earlier section. 

 
4.   Press the RESET button on the Tower MCU module or power cycle the board by removing 

and re-applying the USB cable to the Tower MCU Module. 
 

5. Start your internet browser. Disable any proxy settings and navigate to the target device 
address: 192.168.0.3. 
 

6. You should see “Freescale MQX Web Server” home page in the browser window. 
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7. Copy all the files of the “usb_pages” directory of the twradcdacltc_demosuite_v2.0 to a USB 
stick.  The files should be in the root directory of the removable disk as shown in the figure 
below. 

 

 
 

8. Insert the USB stick into the TWR-SER module using the provided mini-B adapter. 
 

9. Reload the Web server home page by pressing F5 in the browser window. You should see 
the “LTC Mixed Signal Board” option in the menu on the left of the screen. 

 

 

5.1.1 Troubleshooting the Web Server 

If you are unable to communicate from a computer to the embedded web server of the Tower System, 
try the following: 
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1. Ensure the Tower system is assembled correctly. Each tower module has a primary and 

secondary card edge connector. The primary side must be connected to the Primary (or 
Functional in older systems) Elevator.  

2. Ensure that the computer’s internet connection is properly configured and able to connect 
to the web server.  In a command window, try the ipconfig and ping commands to test the 
communication with the Tower System.  
Example: Launch “Command” terminal by clicking Start Menu -> Start Search. In Start 
Search Box enter text “cmd” 
In “Command” terminal enter text “ping 192.168.0.3” as shown below 

 
3. Ensure any proxy settings in your browser are turned off. 
4. Turn off any other network connections (real and virtual).  
5. Configure the laptop network adaptor: 

a. Type ncpa.cpl in the Windows search field. Press Enter.  
 
 

                       
 

 
b. Select the appropriate Ethernet adaptor. Right click and select Properties. 
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c. Select Internet Protocol Version 4. Press Properties. 
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d. Setup the IP address as shown below. Press OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

e. The PC IP should be 192.168.0.4 
  
NOTE:  It is recommended to use Internet Explorer browser. If using any other browser, the cache 
should be cleared. 
 
 

5.2 LTC Configuration Pages 
At the left side of the web server home page, click “LTC Mixed Signal Board" link. A configuration page 
for each of the four Linear Technologies analog converter chips can be found on the left pane of the 
web page under the “Configuration Pages” link.  These pages provide a convenient way to change the 
operational settings of the converter chips and the ability to perform simple input/output operations 
to set values on the DACs or read values from the ADCs. Links to the datasheet for the device are 
provided on each of their respective configuration pages.  
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NOTE: When using the TWR-K60D100M board, you may notice that when clicking the “Set / Read” or 
“Set / Write” buttons on the LTC2704 DAC and LTC2498 ADC Configuration Pages, the network 
connection will drop momentarily and then be restored after a few seconds. This will happen because 
of a hardware issue of the TWR-K60D100M boards that affects web server functionality while 
communicating with the LTC2704 DAC and LTC2498 ADC analog converter chips. The software 
accommodates for this issue by waiting until after the command to the LTC2704 DAC and/or LTC2498 
ADC chip has completed, resetting the Ethernet transceiver and then sending updated data to the web 
page.  
 

5.3 DAC to ADC Loopback 
The steps below describe how to setup the TWR-ADCDAC-LTC for a simple loopback from a DAC output 
to an ADC input. 
 
NOTE: Take care to connect only from the LTC2600 to the LTC2498 and from the LTC2704 to 
the LTC1859.  
 

1. Short the common (COM) pin input to the GND terminal for both the LTC2498 and the 
LTC185 as shown in the picture below. 

 
 

2. Connect a wire from channel A of the LTC2600 to channel 0 of the LTC2498 
3. Connect a wire from channel A of the LTC2704 to channel 0 of the LTC1859 
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4. In the web browser, go to the LTC2600 configuration page and enter a voltage value (e.g. 

“1.8”) in the “Value to Write” field. Leave the other settings at their default value as shown 
below. Click the “Set / Write” button. 
 

 
 

5. Switch to the LTC2498 configuration page.  Select “Single-Ended 0” in the “Channel Setting:” 
drop down box and click the “Set / Read” button. The updated voltage reading will be 
displayed on the page.  Verify that it is approximately the same value set as the output on 
the DAC. 
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6. Repeat steps 4 and 5 above for the LTC2704 DAC and LTC1859 ADC 

5.4 Thermocouple 
The “Thermocouple Reader” link in the menu on the left pane of the web page provides a utility to use 
the LTC2498 as a thermocouple reading device.  Connect the provided thermocouple wire to the 
LTC2498 inputs as shown below (yellow wire to Channel 0 and brown wire to GND). A wire should also 
be connected between COM and GND as shown below. Then, follow the instructions on the 
“Thermocouple Reader” web page.   
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NOTE: When using the TWR-K60D100M board, you may notice that, when clicking the “Set / Read” 
button on the Thermocouple Reader page, the network connection will drop momentarily and then be 
restored after a few seconds. This will happen because of a hardware issue of the TWR-K60D100M 
boards that affects web server functionality while communicating with the LTC2498 DAC analog 
converter chip. The software accommodates for this issue by waiting until the command to the 
LTC2498 DAC chip has been completed, resetting the Ethernet transceiver and then sending the 
updated data to the web page.  
 

5.5 Data Logger and Generator 
The “ADC Datalogger Config” link in the menu on the left pane of the web page provides a utility to 
setup a datalogger using either of the ADCs.  Instructions for using the datalogger are provided at the 
top of the web page. 
 
The samples are stored on the USB stick. Select the required channel of ADC using check box. After the 
“Set / Read” button is clicked, the screen may go blank for sometime and reloads the page while 
sampling with the “Datalogger State” on the web page being displayed as "Sampling...". After the 
sampling completes, the “Datalogger State” then displays the number of samples taken for sampling.   
 

Connect GND to COM 

Channel 0 

GND 



 
 
 

 

 TWR-ADCDAC-LTC Lab Guide Page 28 of 31 
 

 
 
You can access the log file (.csv format) over the internet connection by typing the name of the output 
log file in the address bar of your browser.  For example, if you left the logfile name as the default of 
“output_log” in Datalogger configuration page, then you can access the log file by browsing to  
“  http://192.168.0.3/usb/output_log.csv ” 
 
Note: Please use Internet Explorer  version 9 /Chrome version 31/Firefox version 26 or later. Older 
versions may not work well.  
 
 

http://192.168.0.3/usb/output_log.csv
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a) To open generated Datalogger file, Open Internet Explorer and enter URL of “.csv” file in 
Address bar.  
Example: “  http://192.168.0.3/usb/output_log.csv ”  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://192.168.0.3/usb/output_log.csv
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b) Click on “Save” button when browser prompts to save the file.  
 

 
 

c) Now open downloaded csv file using Microsoft Excel. 
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NOTE: When using the TWR-K60D100M boards in this lab, you may notice that, when clicking the “Set 
/ Read” button on the ADC Datalogger Config page, the network connection will drop momentarily and 
then be restored after a few seconds. This will happen because of a hardware issue of the TWR-
K60D100M boards that affects web server functionality while communicating with the LTC2704 DAC 
and LTC2498 ADC analog converter chips. This issue prevents the web page from dynamically updating 
the “Datalogger State” on the web page after the “Set / Read” button is clicked. The software 
accommodates for this issue by waiting for the datalogging to complete, resetting the Ethernet 
transceiver and then sending the updated data to the web page. If the value that you specify in the 
“Number of samples” field is high enough, the web page refresh may time out before the datalogging 
of samples has completed. If this occurs, you will need to manually refresh the web page.  
 

5.6 Real Time Clock 
The “System Run Time (RTC)” link in the menu on the left pane of the web page provides a utility to  
display the real time clock. Ensure the coin cell battery is installed on the bottom side of the TWR-
K60D100M module to enable to RTC to retain the set time. 
 

 
To synchronize RTC time with the system time, click on “RTC sync” button and reboot the tower. After 
rebooting the tower, the current system time will be displayed on the web page. 


